
 

 

 

 

 

˾˪˷˦˫˦˰ˮ 

˯˪˭ˮ˰ˮ ˮ ˽˳˷ ˭ ˻˫˪˲ˮ ˱ ˳˧˶́˦˲˪˧˦ LightWave 3D-˾ .ˮ 

LightWave ˦˶ˮ˷ ́˰ˮ˪˶ˮ ˴˶˳˨˶˦˱˦ 3D-˱˳˩˪˰ˮ˶˪˧˦˾ˮ, ˦˲ˮ˱˦̀ˮ˦˾ˮ ˩  ˦˫ˮˬ˹˦˰ˮˬ˦̀ˮ˦˾ˮ. ˪ ˷

˴˶˳˩˹˻˸ˮ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˨˦˱˳˫ˮ˽˪˲˳˭ ˷̄˫˦˩˦˷̄˫˦ ˷˺˪˶˳˪˧˾ˮ : ˩˦̂˽˪˧˹˰ˮ 

˴˳˰ˮ˨˶˦˺ˮˮ˷˦˭˫ˮ˷ ˱˦˼˦˰̄˦˶ˮ˷̄˳˫˦˲ˮ ˨˦˱˳˷˦̄˹˰˪˧ˮ˷ ˾˪˻˱˲ˮ˩˦˲ , ˩˦˱˭˦˫˶˪˧˹˰ˮ 

˷˶˹˰˽˳˺ˮ˰ˮ ˪˺˪˻˸˪˧ˮ˭ ˯ˮ˲˳ ˮ˲˩˹˷˸˶ˮ˦˷˦ ˩  ˦ ˸˪˰˪˫ˮˬˮˮ˷˦˭˫ˮ˷. ˴˦˯˪˸ˮ LightWave 

̂˦˶˱˳˨˫ˮ˩˨˪˲˷ ˱˳˩˪˰ˮ˶˪˧ˮ˷˦ ˩  ˦ ˦˲ˮ˱˦̀ˮˮ˷ ˺˦˶˭˳ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˯˶˪˧˹˰˷, ˶ˮ˷ˮ 

˷˦˾˹˦˰˪˧ˮ˭˦̀ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˾˪˫˻˱˲˦˭, ˱˦˨˦˰ˮ˭˦˩ȟ ȱ˸ˮ˸˦˲ˮ˯ˮ˷ȱ ˿˦́ˮ˶˫ˮ˷ ˦˲ˮ˱˦̀ˮ˦, ˦ ˲

˨˦˫˦̀˳̀̄˰˳˭ ˫ ˮ˩˪˳ ˭ ˦˱˦˾ˮ˷ ˨ ˱ˮ˶ˮ. 

˦ ˱ ̂ˮ˨˲ˮ˷ ̂˦˯ˮ˭̄˫ˮ˭ ˷˶˹˰˽˳˺ˮ˰˦˩ ˦˫ˮ˭˫ˮ˷˪˧˭ LightWave 3D-  ˷ ˮ˲˸˪˶˺˪ˮ˷˷, ˦˷˪˫˪ 

̂˦˶˱˳˩˨˪˲ˮ˰ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˾˪˷˦́˰˪˧˰˳˧˪˧˷. ˱ ˮ˹̄˪˩˦˫˦˩ ˮ˱ˮ˷˦ ˶˳ ˱LightWave 3D ˦ ˶ˮ˷ 

́˰ˮ˪˶ˮ ˴˶˳˨˶˦˱˹˰ˮ ˴˶˳˩˹˻˸ˮ, ˮ  ˷˦˩˫ˮ˰˦˩ ˾˪˷˦˷̂˦˫˰ˮ˦ ˩  ˦˦˱˦˷ ˨˦˶˩˦, ˦˩˫ˮ˰ˮ˦ ˱ˮ˷ˮ 

˯˳˲˺ˮ˨˹˶ˮ˶˪˧˦. ˨˦˲̄ˮ˰˹˰ˮ˦ ˩˦˱̂˽˪˧ˮ ˩  ˦ ˴˶˳˺˪˷ˮ˳˲˦˰ˮ ˱˳˱̄˱˦˶˪˧˰˪˧ˮ˷ 

˯˳˲˺ˮ˨˹˶˦̀ˮ˪˧ˮ.  

 

 

 

 

 

 

 

 



 

˴ˮ˶˫˪˰ˮ ˨ ˦˾˫˪˧˦ 

ˮ˲˸˪˶˺˪ˮ˷ˮ LAYOUT 

˨˦˲˫ˮ̄ˮ˰˳˭ ˮ ˲˸˪˶˺˪ˮ˷ˮ Layout(˷˹.˶ 1). 

 

˷˹ ˶1. ˮ ˲˸˪˶˺˪ˮ˷ˮ Layout 

Toolbar (ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴ ˦˲˪˰ˮ) : 

˱˦˷ˬ˪ ˨˦˲˭˦˫˷˪˧˹˰ˮ ˦ ˷̀˪˲ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ. ˮ˷ˮ˲ˮ ˩˦˽˳˺ˮ˰˲ˮ ˦˶ˮ˦˲ 

˺˹˲˻̀ˮ˪˧ˮ˭, ˶ ˦̀ ˦˦˩˫ˮ˰˪˧˷ ˱˦˭ ́˪˧˲˦˷. ˭ ˹˯ˮ ˶˦ˮ˱˪ ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˨˦˱˳́˦̄˪˧˦ ˾˪˷˦́˰˪˧˪˰ˮ˦ 

˯˰˦˫ˮ˦˸˹˶ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭, ˱˦˾ˮ˲ ˦ ˱ ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˦˶˿˪˫ˮ˷ ˼ˮ˰˦˯ˬ˪, ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˷ 

˨˦˱˳˷˦̄˹˰ˮ˦ ˯ ˰˦˫ˮ˦˸˹˶˦ˬ˪ ˼ ˮ˰˦˯˭ ˦˯ ˳˱˧ˮ˲˦̀ˮˮ˷ ˦ ˼̂˪˶˪˧ˮ(˷˹.˶ 2). 

 

˷˹ ˶2. ˭ ˪˭˶ˮ ˦ ˷˳˪˧ˮ ˮ ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴ ˦˲˪˰ˮ˷ ˱ ˦˶̅˫˪˲˦ ˱ ̄˦˶˪˾ˮ, ˨ ˦˲˷˦ˬ˼˫˶˦˫˪˲ ˼ ˮ˰˦˯˪˧ˮ˷ 

˯˳˱˴ˮ˧˦̀ˮ˦˷ ˯ ˰˦˫ˮ˦˸˹˶˦ˬ˪ 



 

Tabs (˿ ˦˲˦˶˭˪˧ˮ) : 

˪˶˭ˮ ˿˦˲˦˶˭ˮ˩˦˲ ˱˪˳˶˪ ˿˦˲˦˶˭ˬ˪ ˨˦˩˦˷˫˰ˮ˷˦˷ ˮ̀˫˰˪˧˦ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˯˶˪˧˹˰ˮ. ˭˹˱̀˦ 

˱˪˲ˮ˹˷ ˴˹˲˻˸˪˧ˮ,  ˨˦˲˰˦˨˪˧˹˰˲ˮ ˦˶ˮ˦˲ ˴˹˲˯˸ Presets (˯ ˳˲˺ˮ˨˹˶˦̀ˮ˪˧ˮ) ˻˫˪˾, ˦ ˱̂˪˷ˮ˭ 

˨˦˲˰˦˨˪˧˹˰ˮ ˹˱˶˦˫˰˪˷ ˾˪˱˭̄˫˪˫˦˾ˮ ˨˦˱˳˽˪˲˪˧˦˩ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ ˩  ˦ ˶˪˩˦˻˸˳˶˪˧ˮ 

˽˳˫˪˰˭˫ˮ˷ ̄ ˪˰˱ˮ˷˦̂˫˩˪˱ˮ˦, ˱ ˮ˹̄˪˩˦˫˦˩ ˮ ˱ˮ˷˦ ˶ ˦ˬ˪ ˱ ˮ˩ˮ˷ ˱ ˹˾˦˳˧˦ ˱ ˮ˱˩ˮ˲˦˶˪ ˩ ˶˳˾ˮ. 

OpenGL Viewport (˴ ˶˳˻˸ˮ˶˪˧ˮ˷ ˺ ˦˲̅˦˶˦ OpenGL) : 

˦ ˱ ˺˦˲̅˦˶˦˾ˮ ˱ˮ˩ˮ˷ ˷˦˱˨˦˲ˬ˳˱ˮ˰˪˧ˮ˦˲ ˷̀˪˲˦ˬ˪ ˱˹˾˦˳˧˦, ˳˧ˮ˪˻˸˪˧ˮ˷ ˱˦˲ˮ˴˹˰˦̀ˮ˦ ˩  ˦

˷˦˱˹˾˦˳˷ ̂ ˮ˲˦˷̂˦˶ˮ ˨ ˦˩˦̄˪˩˫˦.  

Shuttle Control (˷ ˦˱˦˶˭˦˫ˮ ˼ ˮ˰˦˯˪˧ˮ) : 

˱ˮ˱˩ˮ˲˦˶˪ ˼ˮ˰˦˯˪˧ˮ ˷˦˾˹˦˰˪˧˦˷ ˨˫˦́˰˪˫˪˲ ˾˪˫˦˷˶˹˰˳˭ ˷̀˪˲ˮ˷ ˴ˮ˶˩˦˴ˮ˶ˮ, ˹˯,˹ ˦ ˲

˷˦˭ˮ˭˦˳ ˶ ˪˴˶˳˩˹˻̀ˮ˦. 

Keyframe tools (˨ ˦˷˦˼˪˧˹˶ˮ ˯ ˦˩˶˪˧ˮ˷ ˷ ˦˱˦˶˭˦˫ˮ ˮ ˲˷˸˶˹˱˪˲˸˪˧ˮ) : 

˪ ˷˼ˮ˰˦˯˪˧ˮ ˷˦˾˹˦˰˪˧˦˷ ˨˫˦́˰˪˫˪˲ ˦˫˸˳˱˦˸˹˶˦˩ ˾˪˫˻˱˲˦˭ ˨˦˷˦˼˪˧˹˶ˮ ˯˦˩˶˪˧ˮ, ˨˦˫̄˷˲˦˭ 

˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˦˶˦ Create Motion Key (˱ ˳́˶˦˳˧ˮ˷ ˾˪˻˱˲˦), ˦ ˲Delete Motion Key (˱ ˳́˶˦˳˧ˮ˷ 

̂˦˾˰˦). 

Current item menu (˱ ˮ˱˩ˮ˲˦˶˪ ˪ ˰˪˱˪˲˸ˮ˷ ˱ ˪˲ˮ˹) : 

˦ ˱˿˦˱˳˷˦˾˰˪˰ ˱ˮ˲ˮ˹˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ ˨˦˱˳˽˳˺ˮ˰ˮ ˳˧ˮ˪˻˸ˮ˷ ˷˦̄˪˰ˮ. ˫ˮ˱˳˻˱˪˩˳˭ ˮ˷˦˶ˬ˪, 

˶˦˭˦ ˿˦˱˳ˮ˾˦˰˳˷ ˱ˮ˱˩ˮ˲˦˶˪ ˷̀˪˲ˮ˷ ˾˪˱˦˩˨˪˲˪˰ˮ ˳˧ˮ˪˻˸˪˧ˮ˷ ˷˦̄˪˰˪˧ˮ. ˦˱ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭ 

˿˫˪˲ ˦ ˩˫ˮ˰˦˩ ˾ ˪˫́˰˪˧˭ ˱ ˦˭ ˨ ˦˱˳˽˳˺˦˷.  

Message window (˾˪˸˽˳˧ˮ˲˪˧˪˧ˮ˷ ˺ ˦˲̅˦˶˦) : 

˦ ˱ˬ˳˰˾ˮ ˽˳˫˪˰˭˫ˮ˷ ˨˦˱˳ˮ˷˦̄˪˧˦ ˨˦˱˳˽˪˲˪˧˹˰ˮ ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˷˦̄˪˰ˮ ˩  ˦˦˷˪˫˪ Layout 

˾˪˸˽˳˧ˮ˲˪˧˦. 

 

Edit modes (˶ ˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶ ˪˵ˮ˱˪˧ˮ) : 

 

˦ ˱ ˼ˮ˰˦˯˪˧ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶˪˵ˮ˱˪˧ˮ˷ ˱˦˶˭˫˦. ˱˦˨˦˰ˮ˭˦˩, 

˼ˮ˰˦˯ˮ Objects (˳ ˧ˮ˪˻˸˪˧ˮ) ˷˦˾˹˦˰˪˧˦˷ ˨˫˦́˰˪˫˪˲ ˨˦˩˦˫˦˦˩˨ˮ˰˳˭ ˷̀˪˲ˮ˷ ˲˪˧ˮ˷˱ˮ˪˶ˮ 

˳˧ˮ˪˻˸ˮ. Lights (˷ˮ˲˦˭˰ˮ˷ ̂˽˦˶˳˪˧ˮ) ˼ˮ˰˦˯ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭ ˾ ˪˷˦́˰˪˧˪˰ˮ˦ ˷̀˪˲˦ˬ˪ ˦˶˷˪˧˹˰ˮ 

˨˦˲˦˭˪˧ˮ˷ ̂˽˦˶˳˪˧ˮ˷ ˦˩˨ˮ˰˱˩˪˧˦˶˳˪˧ˮ˷ ˾˪̀˫˰˦. ˭˹˯ˮ ˱˳˫˲ˮ˾˲˦˫˭ ˳˧ˮ˪˻˸˷, ˱˦˾ˮ˲ 

˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶ ˪˵ˮ˱ˮ ˦ ˫˸˳˱˦˸˹˶˦˩ ˾ ˪ˮ̀˫˰˪˧˦. 

 

Frame Slider (˯ ˦˩˶˪˧ˮ˷ ˱ ˦˿˫˪˲˪˧˪˰ˮ) : 



 

˨˦˱˳ˮ˽˪˲˪˧˦ ˱ˮ˱˩ˮ˲˦˶˪ ˯˦˩˶ˮ˷ ˦˱˳˷˦̀˲˳˧˦˩. ˦˲ˮ˱˦̀ˮˮ˷ ˬ˳˰ˮ˷ ˱˦˶̅˫˪˲˦ ˩  ˦ ˱˦˶̀̄˪˲˦ 

˱̄˦˶˪˪˧ˬ˪, ˨˦˲˰˦˨˪˧˹˰ˮ˦ ˶ˮ̀̄˫ˮ˭ˮ ˫˪˰˪˧ˮ, ˶˳˱˰˪˧˾ˮ̀ ˱˳˱̄˱˦˶˪˧˪˰ˮ ˱ˮ˹˭ˮ˭˪˧˷ 

˦˲ˮ˱˦̀ˮˮ˷ ˩ ˦̂˽˪˧ˮ˷˦ ˩  ˦˩ ˦˷˶˹˰˪˧ˮ˷ ˯ ˦˩˶˪˧˷. 

Dope Track (˨˦˷˦˼˪˧˹˶ˮ ˯ ˦˩˶˪˧ˮ˷ ˷ ̂˶˦˺ˮ ˶ ˪˩˦˻˸ˮ˶˪˧˦) : 

˨˦˱˳ˮ˽˪˲˪˧˦ ˦˲ˮ˱˦̀ˮˮ˷ ˬ˳˰ˬ˪ ˦˶˷˪˧˹˰ˮ ˨˦˷˦˼˪˧˹˶ˮ ˯˦˩˶˪˧ˮ˷ ˷̂˶˦˺ˮ ˨˦˩˦˦˩˨ˮ˰˪˧ˮ˷, 

˯˳˴ˮ˶˪˧ˮ˷˦ ˩  ˦˿ ˦˷˱ˮ˷˭˫ˮ˷. 

Info numeric fields (ˮ ˲˺˳˶˱˦̀ˮˮ˷ ˶ ˮ̀̄˫ˮ˭ˮ ˫ ˪˰˪˧ˮ) : 

˱ˮ˱˩ˮ˲˦˶˪ ˫˪˰ˮ˷ ̄˪˩ˮ˷ ̀˫˰ˮ˰˪˧˦ ˩˦˱˳˯ˮ˩˪˧˹˰ˮ˦ ˨˦˱˳˽˪˲˪˧˹ ˰ ˮ˲˷˸˶˹˱˪˲˸ˬ˪. ˱ˮ˷ˮ 

˩˦˲ˮ˾˲˹˰˪˧˦˦ ˷˦̃ˮ˶˳ ˮ˲˺˳˶˱˦̀ˮˮ˷ ˨˦˱˳˷˦̄˫˦. ˱˦˨˦˰ˮ˭˦˩, ˭  ˹ ˨˦˩˦˫˦˦˩˨ˮ˰˪˧˭ ˶˦ˮ˱˪ 

˳˧ˮ˪˻˸˷ Move (˨ ˦˩˦˦˩˨ˮ˰˪˧˦) ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭, ˱ˮ˱˩ˮ˲˦˶˪ ˫˪˰˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ 

˳˧ˮ˪˻˸ˮ˷ ˯˳˳˶˩ˮ˲˦˸˪˧ˮ. ˭˹˯ˮ ˳˧ˮ˪˻˸˷ ˨˦˩˦˫˦˦˩˨ˮ˰˪˧˭ Rotate (˸ ˶ˮ˦˰ˮ) ˮ˲˷˸˶˹˱˪˲˸ˮ ˷

˷˦˾˹˦˰˪˧ˮ˭, ˱˦˾ˮ˲ ˱ˮ˱˩ˮ˲˦˶˪ ˫˪˰˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ ˳˧ˮ˪˻˸ˮ˷ ˯˹˭̄˹˶ˮ ˱˩˪˧˦˶˪˳˧˦.  

˾˪˷˦́˰˪˧˪˰ˮ˦ ˦ ˱ ˫˪˰˪˧˾ˮ ˾˪˫ˮ˸˦˲˳˭ ˳˧ˮ˪˻˸˪˧ˮ˷ ˦˩˨ˮ˰˱˩˪˧˦˶˪˳˧ˮ˷ ˬ˹˷˸ˮ 

˯˳˳˶˩ˮ˲˦˸˪˧ˮ, ˭ ˮ˭˳˪˹˰ˮ ˼ ˪˶́ˮ˷˦˭˫ˮ˷. 

ˮ˲˸˪˶˺˪ˮ˷ˮ MODELER 

˨˦˲˫ˮ̄ˮ˰˳˭ ˮ˲˸˪˶˺˪ˮ˷ˮ Modeler(˷ ˹˶. 3). 

 

˷˹˶ 3. ˮ˲˸˪˶˺˪ˮ˷ˮ Modeler 

 



 

 

Toolbar (ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˮ) : 

˶˳˨˳˶̀ Layout-ˮ˷ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪, ˦˻˦̀ ˦˲˦˰˳˨ˮ˹˶˦˩ ˦˶ˮ˷ ˨˦˲˰˦˨˪˧˹˰ˮ 

˱˳˩˪˰ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ. 

Tabs (˿˦˲˦˶˭˪˧ˮ) : 

˶˳˨˳˶̀ Layout-˾ˮ, ˦˻˦̀ ˪˶˭ˮ ˿˦˲˦˶˭ˮ˩˦˲ ˱˪˳˶˪ˬ˪ ˨˦˩˦˷˫˰ˮ˷˦˷ ˮ̀˫˰˪˧˦ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ 

˴˦˲˪˰ˬ˪ Presets (˯ ˳˲˺ˮ˨˹˶˦̀ˮ˪˧ˮ) ˱˪˲ˮ˹˷ ˴˹˻˲˸ˮ˷ ˻˫˪˾ ˨˦˲˰˦˨˪˧˹˰ˮ ˳˴˪˶˦̀ˮ˪˧ˮ˷ 

˾˪˷˦˷˶˹˰˪˧˪˰ˮ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˯˶˪˧˹˰ˮ. 

OpenGL Viewports (˴˶˳˪˻˸ˮ˶˪˧ˮ˷ ˺˦˲̅˦˶˦ OpenGL) : 

Layout-ˮ˷ ˦˲˦˰˳˨ˮ˹˶˦˩ ˳˧ˮ˪˻˸˪˧ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧˦ ˩˦ ˱˦˲ˮ˴˹˰˦̀ˮ˦ ˷˶˹˰˩˪˧˦ 

˴˶˳˪˻˸ˮ˶˪˧ˮ˷ ˺˦˲̅˶˪˧˾ˮ. ˨˦˿˹˱˪˧ˮ˷ ˴˶ˮ˲̀ˮ˴ˮ˭ Layout ˱˳˩˹˰˾ˮ ˦˶ˮ˷ ˱̄˳˰˳˩ ˪˶˭ˮ 

˴˶˳˪˻˸ˮ˶˪˧ˮ˷ ˺˦˲̅˦˶˦, ̄˳˰˳ Modeler ˱˳˩˹˰˾ˮ ˯ˮ ˳˭̄ˮ. ˾˪˷˦́˰˪˧˪˰ˮ˦ ˨˦˲˫˷˦ˬ˼˫˶˳˭ 

˨˦˱˳˷˦̄˹˰ˮ ˺˦˲̅˶˪˧ˮ˷ ˶˦˳˩˪˲˳˧˦. 

Current object menu (˱ˮ˱˩ˮ˲˦˶˪ ˳˧ˮ˪˻˸ˮ˷ ˱˪˲ˮ˹) : 

˦˻ ˽˳˫˪˰˭˫ˮ˷ ˨˦˱˳ˮ˷˦̄˪˧˦ ˶˪˩˦˻˸ˮ˶˪˧˦˩ˮ ˳˧ˮ˪˻˸ˮ˷ ˷˦̄˪˰ˮ. ˭˹˯ˮ ˳˧ˮ˪˻˸˷ ˦˶ 

˩˦˫˦˱˦̄˷˳˫˶˪˧˭ ˶˦ˮ˱˪ ˷˦̄˪˰ˮ˭, ˱˦˾ˮ˲ ˦˱ ˱˪˲ˮ˹˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ ˱ˮ˷ˮ ˷˦̄˪˰ˮ, ˶˳˨˳˶̀ 

Unnamed (˷˦̄˪˰ˮ˷ ˨˦˶˪˾˪). ˭˹˯ˮ ˦˶ ˩˦˫˦˱˦̄˷˳˫˶˪˧˭ ˳˧ˮ˪˻˸˾ˮ ˾˪˸˦˲ˮ˰ ̀˫˰ˮ˰˪˧˪˧˷, ˱˦˾ˮ˲ 

˱ˮ˷ˮ ˷˦̄˪˰ˮ˷ ˨˫˪˶˩ˮ˭ ˨˦˱˳ˮ˷˦̄˪˧˦ ˫˦˶˷˯˫˰˦˫ˮ(˷˹˶. 4). ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˱ˮ˫ˮ˼˳˭ ˷̀˪˲˦ˬ˪ 

˦˶˷˪˧˹˰ˮ ˽˫˪˰˦ ˳˧ˮ˪˻˸ˮ˷ ˷˦̄˪˰ˮ, ˱˦˾ˮ˲ ˫ˮ˱˳˻˱˪˩˳˭ ˱˪˲ˮ˹ˬ˪ ˦˶˷˪˧˹˰ ˮ˷˦˶ˬ˪. 

 

˷˹˶ 4. ˱ˮ˱˩ˮ˲˦˶˪ ˳˧ˮ˪˻˸ˮ˷ ˱˪˲ˮ˹ 

 

Layer bank (˾˶˪˪˧ˮ˷ ˧˦˲˯ˮ) : 

˽˳˫˪˰ ˦˱ ˼ˮ˰˦˯˾ˮ ˱˩˪˧˦˶˪˳˧˷ ˱˳˩˪˰ˮ˷ ˾˶˪˪˧ˮ. ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˪˷˦ ˭˹ ˮ˷ ˾˶˪ ˨˦˫̄˦˩˳˭ 

̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷˦˭˫ˮ˷, ˭˦˨˹˲˦˷ ˱˦˶̀̄˪˲˦ ˼ˮ˰˦˯ˮ˭ ˫ˮ˱˳˻˱˪˩˳˭ ˦˶˷˪˧˹˰ˮ 

˼ˮ˰˦˯ˮ˷ ˬ˪˩˦ ˲˦̂ˮ˰ˬ˪. ˼ˮ˰˦˯ˮ˷ ˻˫˪˩˦ ˲˦̂ˮ˰˾ˮ ˭˦˨˹˲˦˷ ˱˦˶̀̄˪˲˦ ˼ˮ˰˦˯ˮ˭ ˱˳˻˱˪˩˪˧ˮ˷˦˷ 

˳˧ˮ˪˻˸ˮ ˨˦˩˦˩ˮ˷ ˺˳˲˹˶ ˶˪˵ˮ˱˾ˮ. ˾˶˪˪˧ˮ˷ ˧˦˲˯ˮ˷ ˱˦˶̀̄˪˲˦ ˱̄˦˶˪˷ ˦˶˷˪˧˹˰ˮ ˼ˮ˰˦˯˪˧ˮ˭, 

˾˪˷˦́˰˪˧˪˰ˮ˦ ˨˦˩˦˫˦˦˩˨ˮ˰˩˪˭ ̄˪˰˱ˮ˷˦̂˫˩˳˱ ˱ˮ˱˩ˮ˲˦˶˪ ˳˧ˮ˪˻˸ˮ˷ ˾˶˪˪˧ˬ˪. ˨˦˿˹˱˪˧ˮ˷ 

˴˶ˮ˲̀ˮ˴ˮ˭ Layer Bank ˨˦˱˳˷˦̄˦˫˷ ˾˶˪˪˧˷ ˴ˮ˶˫˪˰ˮ˩˦˲ ˱˪˦˭˪˱˩˪, ˭˹˱̀˦ ˳˧ˮ˪˻˸˷ ˾˪˷˦́˰˳˦ 

̆˻˳˲˩˪˷ ˮ˱˩˪˲ˮ ˾˶˪, ˶˦˱˩˪˲˷˦̀ ˷˦̃ˮ˶˳˪˧˦ ˱˳ˮ˭̄˳˫˷. 

6̍́̑ ÅÄÉÔ ÍÏÄÅÓ (˶˹˯˪˧ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶˪˵ˮ˱˪˧ˮ) : 

˦˱ ˼ˮ˰˦˯˪˧ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˨˦˩˦˫˪˶˭˳˭ ˶˹˯˪˧ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˷̄˫˦˩˦˷̄˫˦ 

˶˪˵ˮ˱˪˧˾ˮ. ˸ˮ˴˪˧ˮ˩˦˲ ˭ˮ˭˳˪˹˰ˮ ˶˹˯ˮ˷ ˷˴˪̀ˮ˺ˮ˯˦̀ˮ˦(weight, texture, morph) 

˨˦˲˭˦˫˷˪˧˹˰ˮ˦ ˶˪˵ˮ˱˪˧ˮ˷ ˼ˮ˰˦˯˪˧ˮ˷ ˱˦˶̅˫˲ˮ˫ ˦˶˷˪˧˹˰ ˿˦˱˳˷˦˾˰˪˰ ˱˪˲ˮ˹˾ˮ. 



 

 

Editing commands (˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˧˶́˦˲˪˧˪˧ )ˮ : 

˪˷ ˼ˮ˰˦˯˪˧ˮ ˷˦˾˹˦˰˪˧˦˷ ˨˫˦́˰˪˫˪˲ ˾˪˫˦˷˶˹˰˳˭ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˷˸˦˲˩˦˶˸˹˰ˮ ˳˴˪˶˦̀ˮ˪˧ˮ, 

ˮ˷˪˭˪˧ˮ, ˶˳˨˳˶ˮ̀˦˦, ˯˳˴ˮ˶˪˧˦, ˿˦˷˱˦, ˱˳˻˱˪˩˪˧ˮ˷ ˹˦˶˽˳˺˦ ˩˦ ˦.˾. 

Modes menu (˶˪˵ˮ˱˪˧ˮ˷ ˱˪˲ˮ˹) : 

˦˱ ˱˪˲ˮ˹˾ˮ ˮ˷˱˪˧˦ ˦˱˦ ˭˹ ˮ˱ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˳˴˪˶˦̀ˮˮ˷ ˾˪˷˶˹˰˪˧ˮ˷ ˴˦˶˦˱˪˸˶˪˧ˮ. ˱˦˨˦˰ˮ˭˦˩, 

˭˹ ˱˪˲ˮ˹˷ ˴˹˲˻˸˾ˮ Action Center (˱˳˻˱˪˩˪˧ˮ˷ ̀˪˲˸˶ˮ) ˱ˮ˫˹˭ˮ˭˪˧˭ Mouse (˭˦˨˹˲˦) ˩˦ 

˾˪˱˩˪˨ ˳˧ˮ˪˻˸˷ ˱˳˫˦˸˶ˮ˦˰˪˧˭ ˮ˲˷˸˹˱˪˲˸ˮ˭ Rotate, ˱˦˾ˮ˲ ˸˶ˮ˦˰ˮ ˱˳̄˩˪˧˦ ˭˦˨˹˲˦˷ 

˱˦˿˫˪˲˪˧˰ˮ˷ ˦˩˨ˮ˰˱˩˪˧˦˶˪˳˧ˮ˷ ˱ˮ̄˪˩˫ˮ˭. 

Selection Modes (˨˦˱˳˽˳˺ˮ˷ ˶˪˵ˮ˱˪˧ˮ) : 

˶˳˨˳˶̀ Layout-˾ˮ, ˦˱ ˼ˮ˰˦˯˪˧ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭, ˾˪˷˦́˰˪˧˪˰ˮ˦ ˦˫ˮ˶˿ˮ˳˭ ˷˦˱ˮ ˱˭˦˫˦˶ˮ 

˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶˪˵ˮ˱ˮ˩˦˲ ˪˶˭-˪˶˭ˮ: ̂˪˶˸ˮ˰ˮ, ˴˳˰ˮ˨˳˲ˮ, ̄˦ˬˮ. LightWave-˾ˮ 

˱˳˩˪˰ˮ˶˪˧ˮ˷ ˱˭˪˰ˮ ˦˶˷ˮ ̅˩˪˧˦ ˺˶˦ˬ˦˾ˮ ò˨˦˱˳˽˦˫ˮ ˩˦ ˩˦˦˶˪˩˦˻˸ˮ˶˪ò. ˱˳˩˪˰ˮ˷ 

˶˪˩˦˻˸˳˶˾ˮ ̂˪˶˸ˮ˰˪˧ˮ˷, ˦˲ ˴˳˰ˮ˨˳˲˪˧ˮ˷ ˷˦̃ˮ˶˳ ̅˨˹˺˪˧ˮ˷ ˱˳˷˦˲ˮ˾˲˦˩ ˨˦˲̄ˮ˰˹˰ˮ˦ 

˶˦˱˳˩˪˲ˮ˱˪ ˫˦˶ˮ˦˲˸ˮ. ˶˪˩˦˻˸ˮ˶˪˧ˮ˷ ˶˪˵ˮ˱˪˧˷ ˾˳˶ˮ˷ ̀ˮ˯˰˹˶ˮ ˨˦˩˦˶˭˫˦ ̄˩˪˧˦ 

˯˰˦˫ˮ˦˸˹˶˦ˬ˪ ˦˶˷˪˧˹˰ˮ ˼ˮ˰˦˯ˮ˷ Space-ˮ˷ ˷˦˾˹˦˰˪˧ˮ˭.  

Progress monitor (˴˶˳̀˪˷ˮ˷ ˾˪˷˶˹˰˪˧ˮ˷ ˮ˲˩ˮ˯˦˸˳˶ˮ) : 

˦˻ ˿˫˪˲ ˾˪˨˫ˮ́˰ˮ˦ ˭˫˦˰˽˹˶ˮ ˫˦˩˪˫˲˳˭ ˱ˮ˱˩ˮ˲˦˶˪ ˳˴˪˶˦̀ˮ˦˷. ˷ˮ˲˦˱˩˫ˮ˰˪˾ˮ ˿˫˪˲ ˫˪˶˦˺˪˶˷ 

˾˪˫˦˱˿˲˪˫˭ ˱˦˲˦˱, ˷˦˲˦˱ ˦˶ ˾˪˫˦˷˶˹˰˪˧˭ ˶˭˹˰ ˳˴˪˶˦̀ˮ˪˧˷ ˩ˮ˩ˮ ˶˦˳˩˪˲˳˧ˮ˷ ̂˪˶˸ˮ˰˪˧ˮ˷ 

˩˦ ˴˳˰ˮ˨˳˲˪˧ˮ˷ ˱˻˳˲˪ ˳˧ˮ˪˻˸˪˧ˬ˪. 

Message window (˾˪˸˽˳˧ˮ˲˪˧˪˧ˮ˷ ˺˦˲̅˦˶˦) : 

˦˱ ˬ˳˰˾ˮ ˶˦ˮ˱˪ ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˦˶˿˪˫ˮ˷˦˷ ˨˦˱˳ˮ˷˦̄˪˧˦ ˱ˮ˷ˮ ˨˦˱˳˽˪˲˪˧ˮ˷ ˶˿˪˫˪˧ˮ. 

Information display (ˮ˲˺˳˶˱˦̀ˮ˹˰ˮ ˺˦˲̅˦˶˦) : 

˪˷ ˺˦˲̅˦˶˦ Layout-˾ˮ ˦˶˷˪˧˹˰ˮ ˱ˮ˭ˮ˭˪˧ˮ˷ ˶ˮ̀̄˫ˮ˭ˮ ˫˪˰ˮ˷ ˦˲˦˰˳˨ˮ˹˶ˮ˦. ˱˦˷˾ˮ ˦ˮ˷˦̄˪˧˦ 

˷˦˷˦˶˨˪˧˰˳ ˮ˲˺˳˶˱˦̀ˮ˦ ˷˫˦˩˦˷̄˫˦ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˦˶˿˪˫ˮ˷˦˷. ˭˹˱̀˦ Modeler-˾ˮ ˦˱ 

˺˦˲̅˦˶˦˷ ˫˪˶ ˨˦˱˳˫ˮ˽˪˲˪˧˭ ˶ˮ̀̄˫ˮ˭ˮ ˱˲ˮ˾˫˲˪˰˳˧˪˧ˮ˷ ˾˪˽˫˦˲ˮ˷˦˭˫ˮ˷. 

˭˦˨˹˲˦˷ ˷˦˾˹˦˰˪˧ˮ˭ ˨˦˱˳́˦̄˪˧˹˰ˮ ˱˪˲ˮ˹ : 

˶˳˨˳˶̀ Layout-˾ˮ, ˦˷˪˫˪ Modeler-˾ˮ, ˱˶˦˫˦˰ˮ ˺˹˲˻̀ˮˮ˷ ˷̂˶˦˺˦˩ ˨˦˱˳́˦̄˪˧ˮ˷˦˭˫ˮ˷ 

˨˦˱˳ˮ˽˪˲˪˧˦ ˭˦˨˹˲˦˷ ˼ˮ˰˦˯ˮ˷ ˱˪˾˫˪˳˧ˮ˭ ˨˦˱˳́˦̄˪˧˹˰ˮ ˱˪˲ˮ˹. ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˨˦˱˳˫ˮ́˦̄˳˭ 

˱˪˲ˮ˹, ˯˰˦˫ˮ˦˸˹˶˦ˬ˪ ˫ˮ˱˳˻˱˪˩˳˭ ˼ˮ˰˦˯˪˧ˮ˷ ˯˳˱˧ˮ˲˦̀ˮ˦ˬ˪ Ctrl+Shift ˩˦ ˦˱ ˼ˮ˰˦˯˪˧ˬ˪ 

˭ˮ˭ˮ˷ ˦˹˾˫˪˧˰˦˩ ˫ˮ˱˳˻˱˪˩˳˭ ˭˦˨˹˲˦˷ ˼ˮ˰˦˯ˬ˪. ˭˦˨˹˲˦˷ ˷˦˱ˮ˫˪ ˼ˮ˰˦˯ˬ˪ ˱˳˻˱˪˩˪˧ˮ˭ 

˨˦ˮ̄˷˲˪˧˦ ˷˦˱ˮ ˷̄˫˦˩˦˷̄˫˦˲˦ˮ˶ˮ ˱˪˲ˮ˹. 

LIGHTWAVE ˮ˲˸˪˶˺˪ˮ˷ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮ˦ 



 

ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˱˹˾˦˳˧˦ ˨˦˫̄˦˩˳˭ ˹˺˶˳ ˪˺˪˻˸˹˶ˮ, Modeler-ˮ˷˦ ˩˦ Layout-ˮ˷ ˮ˲˸˪˶˺˪ˮ˷ˮ˷ 

˯˳˲˺ˮ˨˹˶˦̀ˮ˦ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˿˫˪˲-˿˫˪˲ˮ ˾˪̄˪˩˹˰˪˧ˮ˷˦˱˪˧˶ : ˾˪˷˦́˰˪˧˪˰ˮ˦ ˾˪˫̀˫˦˰˳˭ 

˼ˮ˰˦˯˪˧ˮ˷˦ ˩˦ ˱˪˲ˮ˹˪˧ˮ˷ ˦˩˨ˮ˰˱˩˪˧˦˶˪˳˧˦, ˾˪˫˻˱˲˦˭ ˯˳˲˸˪˻˷˸˹˶ˮ ˱˪˲ˮ˹˪˧ˮ ˩˦ 

˩˦˫˲ˮ˾˲˳˭ ˷̂˶˦˺ˮ ˼ˮ˰˦˯˪˧ˮ.  

LAYOUT ˮ ˲˸˪˶˺˪ˮ˷ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮ˦ 

Layout-˾ˮ  ˾˪˫˦˷˶˹˰˳˭ ˱˪˲ˮ˹˷ ˧˶́˦˲˪˧˦ Edit -> Edit Menu Layout (˶˪˩˦˻˸ˮ˶˪˧˦ -> ˱˪˲ˮ˹˷ 

̄˪˩ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧˦). ˨˦˱˳˫˦ ˺˦˲̅˦˶˦ Configure Menus(˷˹˶. 5). 

 

˷˹˶ 5. ˺˦˲̅˦˶˦ Configure Menus 

Menus (˱˪˲ˮ˹˪˧ˮ) ˷˫˪˸˾ˮ ˫ˮ˱˳˻˱˪˩˳˭ Main Menu(˱˭˦˫˦˶ˮ ˱˪˲ˮ˹) ˶˨˳˰ˬ˪, ˶˦˭˦ ˩˦˫ˮ˲˦̄˳˭ 

˨˦˱˳˷ ˦̄˹˰ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˷ˮ˦(˷˹˶. 6). 



 

 

˷˹˶ 6. Menus (˱˪˲ˮ˹˪˧ˮ) ˶˨˳˰˾ˮ ˦˶˷˪˧˹˰ˮ Main Menu(˱˭˦˫˦˶ˮ ˱˪˲ˮ˹) 

ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˨˦˱˳˫ˮ˸˦˲˳˭ ˻˫˪̅˨˹˺ˮ˷ Tools (ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ) ˪˰˪˱˪˲˸˪˧ˮ, ˾˪˫˦˷˶˹˰˳˭ 

˾˪˱˩˪˨ˮ ˳˴˪˶˦̀ˮ˦, Main Menu -> Modify -> General -> Tools(˷˹˶. 7). 

 

˷˹ ˶7. ˻˫˪̅˨˹˺ˮ˷ Tools (ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ) ˪˰˪˱˪˲˸˪˧ˮ 



 

Command (˧˶́˦˲˪˧˪˧ˮ) ˷˫˪˸˾ˮ ˫ˮ˱˳˻˱˪˩˳˭ Bones (́˫˰˪˧ˮ) ˶˨˳˰ˬ˪, ˶ˮ˷ ˾˪˱˩˪˨˦˩˦̀ 

˨˦˱˳ˮ˷˦̄˪˧˦ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˷ˮ˦. ˦˱ ˷ˮ˦˾ˮ ˱˳˫́˪˧˲˳˭ ˴˹˲˻˸ˮ Set Bone Rest 

Length (́˫˰˪˧ˮ˷ ˷ˮ˨˶́ˮ˷ ˩˦˽˪˲˪˧˦)(˷˹˶. 8). 

 

˷˹ ˶ 8. ˴˹˲˻˸ˮ Set Bone Rest Length (́˫˰˪˧ˮ˷ ˷ˮ˨˶́ˮ˷ ˩˦˽˪˲˪˧˦) 

˨˦˩˦˫ˮ˸˦˲˳˭ ˴˹˲˻˸ˮ Set Bone Rest Length ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˾ˮ, ˮ˷˪ ˶˳˱ Sliders 

(˱ˮ˱˭ˮ˭˪˧˰˪˧ˮ) ˶˨˳˰ˮ˷ ˻˫˪˾ ˨˦˿˲˩˪˷ ̀ˮ˷˺˪˶ˮ ˬ˳˰ˮ(˷˹˶. 9).  

 

˷˹˶ 9. ˴˹˲˻˸ Set Bone Rest Length ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˾ˮ ˨˦˩˦˸˦˲˦ 



 

˫ˮ˱˳˻˱˪˩˳˭ Done ˼ˮ˰˦˯ˬ˪. ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˻˫˪̅˨˹˺˾ˮ Tools ˨˦˿˲˩˦ ˦̄˦˰ˮ 

˼ˮ˰˦˯ˮ Set Rest Length(˷˹˶. 10). 

 

˷˹˶ 10. ˻˫˪̅˨˹˺˾ˮ Tools ˨ ˦˿˪˲ˮ˰ˮ ˦̄˦˰ˮ ˼ˮ˰˦˯ˮ Set Rest Length 

 

˺˦˲˦̅˦˶˦ Configure Menus ˾˪ˮ̀˦˫˷ ˳˶ ˮ˪˶˦˶˻ˮ˹˰ ˷ˮ˦˷. Command (˧˶́˦˲˪˧˪˧ˮ) ˨˦˲˭˦˫˷˪˧˹˰ˮ˦ 

˱˦˶̀̄˲ˮ˫, ˱˦˷˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˺˹˲˻̀ˮ˪˧ˮ. ˱˦˶̅˫˲ˮ˫ ˨˦˲˭˦˫˷˪˧˹˰ˮ˦ Menus 

(˱˪˲ˮ˹˪˧ˮ) ˷ˮ˦, ˷˦˩˦̀ ˨˦˱˳ˮ˷˦̄˪˧˦ ˱ˮ˱˩ˮ˲˦˶˪ ˱˳˱˪˲˸˾ˮ ˱˪˲ˮ˹˷ ˾˪˱˦˩˨˪˲˰˳˧˦. ˺˦˲̅˶ˮ˷ 

˱˦˶̀̄˪˲˦ ˱̄˦˶˪˷ ˦˶˷˪˧˹˰ˮ ˦˶˦̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˺˹˲˻̀ˮ˪˧ˮ ˹˯˫˪ ˾˪˸˦˲ˮ˰ˮ˦ ˱˪˲ˮ˹˾ˮ. 

Menus ˷˫˪˸˾ˮ ˩˦˫ˮ˲˦̄˦˫˭ ˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶˪˧˷, ˱˦˨˦˰ˮ˭˦˩, Top Group (ˬ˪˩˦ ˱˪˲ˮ˹), Main 

Menu (˱˭˦˫˦˶ˮ ˱˪˲ˮ˹), Left Mouse Button Menu (˭˦˨˹˲˦˷ ˱˦˶̀̄˪˲˦ ˼ˮ˰˦˯ˮ˷ ˱˪˲ˮ˹). ˷ˮˮ˷ 

˪˰˪˱˪˲˸˪˧ˮ ˭˦˫˷˩˪˧ˮ˦˲ ˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶˪˧ˮ˷ ˻˫˪˾ - ˪˷ ˦˶ˮ˷ ˻˫˪ ˱˪˲ˮ˹. Top Group - ˷˶˹˰ˮ˦˩ 

˨˦˲˷˦˯˹˭˶˪˧˹˰ˮ ˴˹˲˻˸ˮ˦. ˽˫˪˰˦˺˪˶ˮ ˶˦̀ ˨˦˲˭˦˫˷˪˧˹˰ˮ˦ ˦˱ ˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶˪˧ˮ˷ ˻˫˪˾, 

˽˳˫˪˰˭˫ˮ˷ ˨˦˱˳ˮ˷˦̄˪˧˦ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˮ˷ ˬ˪˩˦ ˲˦̂ˮ˰˾ˮ, ˱ˮ˹̄˪˩˦˫˦˩ ˮ˱ˮ˷˦ ˭˹ ˶˦ 

˳˴˪˶˦̀ˮ˦˷ ˫˦˷˶˹˰˪˧˭ ˱ˮ˱˩ˮ˲˦˶˪ ˱˳˱˪˲˸˾ˮ. 

˱ˮ˫˦˻̀ˮ˳˭ ˽˹˶˦˩˼˪˧˦ ˮ˱˦˷ ˶˳˱ ˬ˳˨ˮ˪˶˭ ˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶˪˧˭˦˲ ˨˦˱˳˷˦̄˹˰ˮ˦ ˮ˷˦˶ˮ, ˦˲ 

̂˪˶˸ˮ˰ˮ, ˬ˳˨ˮ˪˶˭˭˦˲ ˯ˮ ˷˦˪˶˭˳˩ ˦˶˦˺˪˶ˮ. ˮ˷˶˪˧ˮ˭ ˩˦˲ˮ˾˲˹˰ˮ ˷ˮˮ˷ ˪˰˪˱˪˲˸˪˧ˮ ˦˶ˮ˦˲ 

˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶˪˧ˮ. ̂˪˶˸ˮ˰˪˧ˮ˭ ˦˼˲ˮ˾˲˹˰ˮ ˷ˮˮ˷ ˪˰˪˱˪˲˸˪˧ˮ ̂˦˶˱˳˦˩˨˪˲˪˲ ˼ˮ˰˦˯˪˧˷, ˦˲ 

˱˪˲ˮ˹˷ ˴˹˲˻˸˪˧˷. ˦˶˦˲˦ˮ˶ˮ ˲ˮ˾˲ˮ˭ ˦˼˲ˮ˾˲˹˰ˮ ˪˰˪˱˪˲˸˪˧ˮ ̂˦˶˱˳˦˩˨˪˲˪˲ ̅˨˹˺˪˧˷. 

˾˪˷˦́˰˪˧˪˰ˮ˦ ˦˶˦˱˦˶˸˳ ˦˶˷˪˧˹˰ˮ ˱˪˲ˮ˹˷ ˾˪˱˦˩˨˪˲˰˳˧ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧˦, ˦˶˦˱˪˩ 

˺˳˶˱˦˸ˮ˶˪˧˦̀. ́˦˰ˬ˪˩ ˱˳˷˦̄˪˶̄˪˧˪˰ˮ˦ ̄˾ˮ˶˦˩ ˨˦˱˳˽˪˲˪˧˦˩ˮ ˳˴˪˶˦̀ˮ˪˧ˮ˷ ˿˦˲˦˶˭˪˧ˮ˷ 

˾˪˻˱˲˦. 

 

˦̄˦˰ˮ ˿˦˲˦˶˭˪˧ˮ˷ ˾˪˻˱˲˦ 

 

¶ ˾˪˫˦˷˶˹˰˳˭ Layout ˮ˲˸˪˶˺˪ˮ˷ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮˮ˷ ˴ˮ˶˫˪˰ˮ ˲˦˧ˮ̅ˮ. 

¶ ˱˦˶̅˫˪˲˦ ˮ˪˶˦˶˻ˮ˹˰ ˱˪˲ˮ˹˾ˮ ˨˦˱˳˫˽˳˭ ˴˹˲˻˸ˮ Main Menu (˱˭˦˫˦˶ˮ ˱˪˲ˮ˹). 

¶ ˫ˮ˱˳˻˱˪˩˳˭ ˼ˮ˰˦˯ˬ˪ New Group (˦̄˦˰ˮ ̅˨˹˺ˮ)(˷˹˶. 11). ˱˳̂ˮ˲˦˫˪ ˷˦˭˦˹˶ˮ˷ Main 

Menu-˷ ˻˫˪˾ ̂˦˶˱˳ˮ˾˫˪˧˦ ˴˹˲˻˸ˮ New Group, ̄˳˰˳ ˮ˲˸˪˶˺˪ˮ˷˾ˮ ˯ˮ ˦̄˦˰ˮ ˿˦˲˦˶˭ˮ 

˦˱˦˫˪ ˷˦̄˪˰ˮ˭(˷˹˶. 11). 



 

 

˷˹ ˶11. ˦ ̄˦˰ˮ ˿ ˦˲˦˶˭˪˧ˮ˷ ˾ ˪˻˱˲˦ 

¶ ˺˦˲̅˦˶˦ Configure Menus ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˾ˮ ˫ˮ˱˳˻˱˪˩˳˭ ˴˹˲˻˸ˬ˪ New Group  

¶ ˫ˮ˱˳˻˱˪˩˳˭ ˼ˮ˰˦˯ˬ˪ Rename (˷˦̄˪˰ˮ˷ ˾˪̀˫˰˦) ˩˦ ˨˦˱˳˷˹˰ ˩ˮ˦˰˳˨˹˶ ˺˦˲̅˦˶˦˾ˮ 

˾˪˫ˮ˽˫˦˲˳˭ ˷˦̄˪˰ˮ My Tools (˿ ˪˱ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ), ̄˳˰˳ ˾˪˱˩˪˨ ˫ˮ˱˳˻˱˪˩˳˭ 

˯˰˦˫ˮ˦˸˹˶˦ˬ˪ ˦˶˷˪˧˹˰ Enter ˼ˮ˰˦˯ˬ˪, ˦˲ ˩ˮ˦˰˳˨˹˶ ˺˦˲̅˦˶˦˾ˮ ˦˶˷˪˧˹˰ OK 

˼ˮ˰˦˯ˬ˪(˷˹˶. 12). 

 

˷˹˶ 12. ˦̄˦˰ˮ ˿˦˲˦˶˭ˮ˷ ˷˦̄˪˰ˮ˷ ˾˪̀˫˰˦ 

¶ ˺˦˲̅˶ˮ˷ ˱˦˶̀̄˪˲˦ ˱̄˦˶˪˾ˮ, ˧˶́˦˲˪˧˪˧ˮ˷ ˷˫˪˸˾ˮ ˫ˮ˱˳˻˱˪˩˳˭ Cameras (˯˦˱˪˶˪˧ˮ) 

˶˨˳˰ˬ˪, ˶ˮ˷ ˾˪˱˩˪˨˦˩˦̀ ˨˦˱˳˫˦ ˽˫˪˰˦ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˮ˲˷˸˶˹˱˪˲˸ˮ. 



 

¶ ˨˦˩˦˫ ˮ˸˦˲˳˭ Camera Zoom Factor (˱˦˷˾˸˦˧ˮ˶˪˧˦) ˮ˲˷˸˶˹˱˪˲˸ˮ ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ 

˱̄˦˶˪˾ˮ, ˮ˷˪ ˶˳˱ My Tools ˷˦˭˦˹˶ˮ˷ ˻˫˪˾ ˨˦˿˲˩˪˷ ̀ˮ˷˺˪˶ˮ ˬ˳˰ˮ(˷˹˶. 13). 

 

˷˹˶ 13. ˦̄˦˰ ˿˦˲˦˶˭˾ˮ ˯˳˱˴˳˲˪˲˸˪˧ˮ˷ ˨˦˩˦˸˦˲˦ 

¶ ˫ˮ˱˳˻˱˪˩˳˭ ˿˦˲˦˶˭ My Tools-ˬ˪, ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˨˦˱˳˿˲˩˪˧˦ Camera Zoom 

Factor(˷˹˶. 14). 

 

˷˹˶ 14. ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˨˦˿˪˲ˮ˰ˮ ˦̄˦˰ˮ ˯˳˱˴˳˲˪˲˸ˮ 



 

˱˦˶˯ˮ˶˪˧˹˰ˮ ˱˪˲ˮ˹˷ ˶˪˷˸˦˫˶˦̀ˮ˦ 

1. ˾˪˫˦˷˶˹˰˳˭ Layout ˮ˲˸˪˶˺˪ˮ˷ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮˮ˷ ˴ˮ˶˫˪˰ˮ ˲˦˧ˮ̅ˮ. 

2. Configure Menus ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˾ˮ ˦˶˷˪˧˹˰ ˿˦˱˳˷˦˾˰˪˰ Presets ˱˪˲ˮ˹˾ˮ 

˦˫ˮ˶˿ˮ˳˭ Default (˨˦˿˹˱˪˧ˮ˷ ˴˶ˮ˲̀ˮ˴ˮ)(˷˹˶. 15). 

 

˷˹˶ 15. ˱˦˶˯ˮ˶˪˧˹˰ˮ ˱˪˲ˮ˹˷ ˶˪˷˸˦˫˶˦̀ˮ˦ 

˷̂˶˦˺ˮ ˼ˮ˰˦˯˪˧ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮ˦ 

˿˫˪˲ ˾˪˨˫ˮ́˰ˮ˦ ˷̄˫˦˩˦˷̄˫˦ ˮ˲˷˸˶˹˱˪˲˸˪˧˭˦˲ ˩˦ ˺˹˲˻̀ˮ˪˧˭˦˲ ˷̂˶˦˺˦˩ ˱ˮ˼̂˪˫ˮ˷˦˭˫ˮ˷ 

˩˦˫˲ˮ˾˲˳˭ ˼ˮ˰˦˯˪˧ˮ ˿˫˪˲ˮ˫˪ ˲˪˧ˮ˭. ˨˦˿˹˱˪˧ˮ˷ ˴˶ˮ˲̀ˮ˴ˮ˭ ˽˳˫˪˰ ˺˹˲˻̀ˮ˦˷ ˩˦ ˮ˲˷˸˶˹˱˪˲˸˷ 

˦˶ ˦˻˫˷ ˩˦˲ˮ˾˲˹˰ˮ ˷̂˶˦˺ˮ ˼ˮ˰˦˯ˮ, ˱˦˨˶˦˱ ˿˫˪˲ ˾˪˨˫ˮ́˰ˮ˦ ˩˦˫˲ˮ˾˲˳˭ ˮ˷ˮ˲ˮ ̄˾ˮ˶˦˩ 

˨˦˱˳˽˪˲˪˧˦˩ ˺˹˲˻̀ˮ˪˧˷˦ ˩˦ ˮ˲˷˸˶˹˱˪˲˸˪˧ˬ˪. ˷˦̃ˮ˶˳ ˮ˲˷˸˶˹˱˪˲˸˭˦˲ ˩˦˷˦˯˦˫˾ˮ˶˪˧˪˰ˮ 

˷̂˶˦˺ˮ ˼ˮ˰˦˯ˮ˷ ˩˦˱˦̄˷˳˫˶˪˧˦ ˦˩˫ˮ˰ˮ˦. ˺˦˲̅˦˶˦ Configure Keys (˯ ˰˦˫ˮ˦˸˹˶ˮ˷ 

˯˳˲˺ˮ˨˹˶˦̀ˮ˦) ˾˪˱˦˩˨˪˲˰˳˧ˮ˭ ˩˦ ̄˪˩ˮ˭ ˦˲˦˰˳˨ˮ˹˶ˮ˦ ˺˦˲̅˦˶ˮ˷˦ Configure Menus (˱ ˪˲ˮ˹˷ 

˯˳˲˺ˮ˨˹˶˦̀ˮ˦). 

˷̂˶˦˺ˮ ˼ ˮ˰˦˯˪˧ˮ˷ ˩ ˦˲ˮ˾˫˲˦ 
Layout ˮ˲˸˪˶˺˪ˮ˷˾ˮ ˾˪˫˦˷˶˹˰˳˭ ˱˪˲ˮ˹˷ ˧˶́˦˲˪˧˦ Edit ->Edit Keyboard Shortcuts 

(˶˪˩˦˻˸ˮ˶˪˧˦ -> ˷̂˶˦˺ˮ ˼ˮ˰˦˯˪˧ˮ˷ ˶˪˩˦˻˸ˮ˶˪˧˦). ˨ ˦˱˳˫˦ ˺˦˲̅˦˶˦ Configure Keys (˷˹˶. 16). 

 

˷˹˶ 16. ˺˦˲̅˦˶˦ Configure Keys 



 

˺˦˲̅˶ˮ˷ ˱˦˶̀̄˪˲˦ ˱̄˦˶˪˾ˮ ˦˶˷˪˧˹˰ ˮ˪˶˦˶˻ˮ˹˰ ˱˪˲ˮ˹˾ˮ Command (˧˶́˦˲˪˧˪˧ˮ) ˨˦˫̄˷˲˦˭ 

˶˨˳˰ˮ Objects (˳˧ˮ˪˻˸˪˧ˮ). ˪˯˶˦˲ˬ˪ ˨˦˱˳˿˲˩˪˧˦ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ. 

˨˦˩˦˫ˮ˸˦˲˳˭ Add Null (˲˹˰˳˫˦˲ˮ ˳˧ˮ˪˻˸ˮ˷ ˩˦˱˦˸˪˧˦) ˮ˲˷˸˶˹˱˪˲˸ˮ ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ 

˱̄˦˶˪˾ˮ, ˮ˷˪ ˶˳˱ Ctrl+A ˴˹˲˻˸ˮ˷ ˬ˪˱˳˭ ˨˦˿˲˩˪˷ ̀ˮ˷˺˪˶ˮ ˬ˳˰ˮ(˷˹˶. 17). ˦̂ˮ ˦˱ ˯˳˱˧ˮ˲˦̀ˮ˦ˬ˪ 

˭ˮ˭ˮ˷ ˩˦̃˪˶ˮ˭ ˷̀˪˲˦ˬ˪ ˩˦˪˱˦˸˪˧˦ ˲˹˰˳˫˦˲ˮ ˳˧ˮ˪˻˸ˮ.  

 

˷˹˶ 17. Add Null (˲˹˰˳˫˦˲ˮ ˳˧ˮ˪˻˸ˮ˷ ˩˦˱˦˸˪˧˦) ˮ˲˷˸˶˹˱˪˲˸ˮ˷ ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˱̄˦˶˪˾ˮ 

˨˦˩˦˸˦˲˦ 

ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˩˦˫̄˹˶˳˭ ˺˦˲̅˦˶˦ Configure Keys ˫ˮ˱˳˻˱˪˩˳˭ ˼ˮ˰˦˯ˬ˪ Done (˩˦˷˶˹˰˪˧˦). 

SCENE EDITOR 

Scene Editor (˷ ̀˪˲ˮ˷ ˱˪˲˪̅˪˶ˮ) ˩˦˲ˮ˾˲˹˰ˮ˦ ˷̀˪˲ˮ˷ ˾˪˱˦˩˨˪˲˪˰ˮ ˽˫˪˰˦ ˪˰˪˱˪˲˸ˮ˷ 

˨˦˱˳˷˦˷˦̄˦˫˦˩. ˱ˮ˷ˮ ˨˦̄˷˲ˮ˷˦˭˫ˮ˷ ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˦˫ˮ˶˿ˮ˳˭ Scene Editor, ˦˲ 

˫ˮ˱˳˻˱˪˩˳˭ ˼ˮ˰˦˯˪˧ˮ˷ ˯˳˱˧ˮ˲˦̀ˮ˦ˬ˪ Ctrl+F1 (˷˹˶. 18). 



 

 

˷˹˶ 18. Scene Editor (˷ ̀˪˲ˮ˷ ˱˪˲˪̅˪˶ˮ) 

˿˦˲˦˶˭˾ˮ Items (˪˰˪˱˪˲˸˪˧ˮ) ˨˦˱˳ˮ˷˦̄˪˧˦ ˷̀˪˲ˮ˷ ˽˫˪˰˦ ˪˰˪˱˪˲˸ˮ. ˪˰˪˱˪˲˸ˮ˷ ˭ˮ˭˳˪˹˰ 

˸ˮ˴˷ ˨˦˦˿˲ˮ˦ ˷˦˯˹˭˦˶ˮ ˦ˮ˶˰ˮ˽ˮ. ˽˹˭ˮ ̂˦˶˱˳˦˩˨˪˲˷ ˳˧ˮ˪˻˸˷, ́˫˦˰ˮ - ́˫˦˰˷, ˲˦˭˹˶˦ - 

˷ˮ˲˦˭˰ˮ˷ ̂˽˦˶˳˷, ˯˦˱˪˶˦ - ˯˦˱˪˶˦˷. ˷ˮˮ˷ ˦˱˦ ˭˹ ˮ˱ ˪˰˪˱˪˸˭˦˲ ˦˶˷˪˧˹˰ + ˼ˮ˰˦˯ˬ˪ 

˱˳˻˱˪˩˪˧ˮ˭ ˪˯˶˦˲ˬ˪ ˨˦˱˳ˮ˷˦̄˪˧˦ ˦˲ˮ˱˦̀ˮˮ˷ ˦˶̄˪˧ˮ, ˦˷˪˫˪ ˦˲ˮ˱˦̀ˮˮ˷ ˬ˳˰ˬ˪ ˭ˮ˭˳˪˹˰ˮ 

˪˰˪˱˪˲˸ˮ˷ ˨˦˷˦˼˪˧˹˶ˮ ˯˦˩˶˪˧ˮ˷ ˨˦˲˰˦˨˪˧˦.  

ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˷̀˪˲ˮ˷ ˪˰˪˱˪˲˸ˮ ˨˦˫̄˦˩˳˭ ̄ˮ˰˹˰ˮ ˿˦˫˶˭˳˭ ˨˦˩˦˱˶˭˫˪˰ˮ Visibility  

(̄ˮ˰˹˰˳˧˦). ò˭˫˦˰ˮ˷ò ˮ˦˶˰ˮ˽ˮ˭ ˦˼˲ˮ˾˲˹˰ ˷˫˪˸˾ˮ ˱ˮ˭ˮ˭˪˧˹˰ˮ˦ ˳˧ˮ˪˻˸ˮ˷ ˨˦˱˳˷˦̄˫ˮ˷ 

˱ˮ˱˩ˮ˲˦˶˪ ˩˳˲˪. ˱ˮ˷ˮ ˾˪̀˫˰˦ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˿˦˱˳˷˦˾˰˪˰ ˱˪˲ˮ˹˾ˮ ˷˦̃ˮ˶˳ ˩˳˲ˮ˷ ˦˶˿˪˫ˮ˭. 

ò˧˳˻˰˳˱ˮ˷ò ˮ˦˶˰ˮ˽ˮ˭ ˦˼˲ˮ˾˲˹˰ˮ ˷˫˪˸ˮ ˨˦˲˷˦ˬ˼˫˶˦˫˷, ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ˦, ˭˹ ˦˶˦ ˱ˮ˱˩ˮ˲˦˶˪ 

˳˧ˮ˪˻˸ˮ ˶˪˩˦˻˸ˮ˶˪˧ˮ˷˦˭˫ˮ˷.  

Items ˿˦˲˦˶˭ˮ˷ ˷ˮˮ˷ ˪˶˭-˪˶˭ˮ ˱˭˦˫˦˶ˮ ˭˫ˮ˷˪˧˦˦, ˮ˷ ˶˳˱ ˱˦˷˾ˮ ˨˦˱˳ˮ˷˦̄˪˧˦ ˷̀˪˲ˮ˷ 

˪˰˪˱˪˲˸˪˧˷ ˾˳˶ˮ˷ ˯˦˫˾ˮ˶ˮ ˮ˷˪˫˪, ˶˳˨˳˶̀, ˱˦˨˦˰ˮ˭˦˩, ò˱˾˳˧˪˰ˮ-˧˦˫˾˫ˮò. ˭˹˯ˮ ˷˫˪˸˾ˮ, 

˶˳˱˪˰ˮ˱˪ ˪˰˪˱˪˲˸˷ ˦˻˫˷ ˱˦˶̀̄˲ˮ˫ ˱ˮ˱˭ˮ˭˪˧˪˰ˮ ˮ˷˦˶ˮ, ˱˦˾ˮ˲ ˪˷ ˲ˮ˾˲˦˫˷ ˶˳˱ ˪˰˪˱˪˲˸ˮ˷ 

˷˦˶˨˪˧˰ˮ˦˲˳˧˦ ˦˶ˮ˷ ˧˦˫˾˫ˮ. ˱˦˷ˬ˪ ˱˳˻˱˪˩˪˧ˮ˭ ˿˫˪˲ ˱ˮ˫ˮ˼˪˧˭ ˲˪˧˦˶˭˫˦˷ ˷ˮˮ˷ ˩˦˱˳˯ˮ˩˪˧˹˰ 

˪˰˪˱˪˲˸˪˧ˬ˪. ˾˪˷˦́˰˪˧˪˰ˮ˦ ˦˱ ˷ˮˮ˷ ˪˰˪˱˪˲˸˪˧ˮ˷ ˭˦˫ˮ˷˹˺˰˦˩ ˨˦˩˦˦˩˨ˮ˰˪˧˦, ˯˦˫˾ˮ˶ˮ˷ 

˩˦˽˪˲˪˧˦, ˦˲ ˨˦̂˽˫˪˸˦. 

˦˲ˮ˱˦̀ˮˮ˷ ˬ˳˰ˮ˷ ˩˦̄˱˦˶˪˧ˮ˭ ˾˪˷˦́˰˪˧˪˰ˮ˦ ˪˰˪˱˪˲˸˪˧ˮ˷ ˨˦˷˦˼˪˧˹˶ˮ ˯˦˩˶˪˧ˮ˷ 

˨˦˩˦˦˩˨ˮ˰˪˧˦ ˩˦ ˱˦˷˾˸˦˧ˮ˶˪˧˦. ˫ˮ˱˳˻˱˪˩˳˭ ˦˲ˮ˱˦̀ˮˮ˷ ˬ˳˰ˬ˪ ˩˦ ˭˦˨˹˲˦˷ ˼ˮ˰˦˯ˬ˪ ˭ˮ˭ˮ˷ 



 

˦˹˾˫˪˧˰˦˩ ˨˦˩˦˫˦˦˩˨ˮ˰˳˭ ˱ˮ˱˭ˮ˭˪˧˪˰ˮ ̂ˮ˲, ˦˲ ˹˯˦˲. ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ ˱˦˷˾˸˦˧ˮ˶˪˧˦ 

˨˦˫˹˯˪˭˳˭ ˱˳́˶˦˳˧˦˷, ˫ˮ˱˳˻˱˪˩˳˭ ˱˦˲ˮ˴˹˰˦˸˳˶ˮ˷ ˲ˮ˾˦˲ˬ˪ ˩˦ ˨˦˩˦˫˦˦˩˨ˮ˰˳˭ ˮ˨ˮ. 

HUB 

Hub (˯ ˫˦˲́ˮ) - ˦˶ˮ˷ LightWave-ˮ˷ ˺˳˲˹˶ˮ ˯˳˱˴˳˲˪˲˸ˮ, ˶˳˱˪˰ˮ̀ Layout ˩  ˦ Modeler 

ˮ˲˸˪˶˺˪ˮ˷˪˧˷ ˷˦˾˹˦˰˪˧˦˷ ˦́˰˪˫˷ ˨˦̀˫˦˰˳˲ ˮ˲˺˳˶˱˦̀ˮ˪˧ˮ. ˷̄˫˦ ˷ˮ˸˽˫˪˧ˮ˭ Hub ˱˹˾˦˳˧˷ 

˾˪˱˩˪˨ˮ ˴˶ˮ˲̀ˮ˴ˮ˭ : Modeler ˮ˲˸˪˶˺˪ˮ˷˾ˮ ˾˪˻˱˲ˮ˰ˮ ˩˦ ˩˦˱˦̄˷˳˫˶˪˧˹˰ˮ ˳˧ˮ˪˻˸ˮ 

˨˦˩˦˪̀˪˱˦ Hub-˷, ˶˳˱˪˰ˮ̀ ˭˦˫ˮ˷˭˦˫˦˩ ˹˭˦˶˨˱˲ˮ˷ Layout ˮ˲˸˪˶˺˪ˮ˷˷. ˦˲˦˰˳˨ˮ˹˶˦˩   

Layout ˮ˲˸˪˶˺˪ˮ˷˾ˮ ˾˪˻˱˲ˮ˰ˮ ˩˦ ˩˦˱˦̄˷˳˫˶˪˧˹˰ˮ ˳˧ˮ˪˻˸ˮ ˨˦˩˦˪̀˪˱˦ Hub-˷, ˶˳˱˪˰ˮ̀ 

˭˦˫ˮ˷˭˦˫˦˩ ˹˭˦˶˨˱˲ˮ˷ Modeler ˮ˲˸˪˶˺˪ˮ˷˷. ˽˫˪˰˦ ̀˫˰ˮ˰˪˧˦ - ˬ˪˩˦˴ˮ˶ˮ˷, ˨˪˳˱˪˸˶ˮˮ˷ ˩˦ 

˦.˾. ˦˫˸˳˱˦˸˹˶˦˩ ̄˳˶̀ˮ˪˰˩˪˧˦ ˳˶ˮ˫˪ ˮ˲˸˪˶˺˪ˮ˷˾ˮ ˩˦ ˨˦˱˳ˮ˷˦̄˪˧ˮ˦˲ ˱˦˭˾ˮ ˨˦˩˦˶˭˫ˮ˷˦˷. 

˭˹˱̀˦ Modeler ˭˦˫ˮ˷ˮ˭ ˦˶ ˨˦˨ˬ˦˫˲ˮ˷ ˾˪˻˱˲ˮ˰ ˳˧ˮ˪˻˸˷ Layout-˾ˮ. ˪˷ ˹˲˩˦ ˨˦˯˪˭˩˪˷ 

˱˳˱̄˱˦˶˪˧˰ˮ˷ ˱ˮ˪˶. 

˳˧ˮ˪˻˸ˮ˷ ˨˦˩˦˽˫˦˲˦ LAYOUT ˮ ˲˸˪˶˺˪ˮ˷˾ˮ 

˨˦˫̄˷˲˦˭ Modeler ˮ˲˸˪˶˺˪ˮ˷ˮ 

ˮ˲˷˸˶˹˱˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˾˪˫˦˷˶˹˰˳˭ ˱˪˲ˮ˹˷ ˧˶́˦˲˪˧˦ File (˺˦ˮ˰ˮ) -> Load(˿ ˦˸˫ˮ˶˭˫˦) -> 

Load Object (˳˧ˮ˪˻˸ˮ˷ ˿˦˸˫ˮ˶˭˫˦)(˷˹˶. 19). ˨˦ˮ̄˷˲˪˧˦ ˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˦˶˦. 

 

˷˹˶ 19. ˳˧ˮ˪˻˸ˮ˷ ˿˦˸˫ˮ˶˭˫ˮ˷ ˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˶ˮ˷ ˨˦˱˳́˦̄˪˧˦ 

 



 

˨˦˱˳˷˹˰ ˺˦˲̅˦˶˦˾ˮ ˦˫ˮ˶˿ˮ˳˭ ˳˧ˮ˪˻˸ˮ ˩˦ ˫ˮ˱˳˻˱˪˩˳˭ Open ˼ˮ˰˦˯ˬ˪(˦˲ ˾˪˫˻˱˲˦˭ ˦̄˦˰ˮ 

˳˧ˮ˪˻˸ˮ). ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˬ˪˩˦ ˯˹˭̄˪˾ˮ ˦˶˷˪˧˹˰ Hub (˯˫˦˲́ˮ) ˿˦˱˳˷˦˾˰˪˰ ˱˪˲ˮ˹˾ˮ(˷˹˶. 

20) ˨˦˱˳˫˽˳˭ ˴˹˲˻˸ˮ Send Object to Layout (˳˧ˮ˪˻˸ˮ˷ ˨˦˨ˬ˦˫˲˦ Layout-˾ )ˮ(˷˹˶. 21). 

 

˷˹˶ 20. ˺˦˲̅˶ˮ˷ ˱˦˶̅˫˪˲˦ ˬ˪˩˦˯˹˭̄˪˾ˮ ˦˶˷˪˧˹˰ Hub (˯˫˦˲́ˮ) ˿˦˱˳˷ ˦˾˰˪˰ ˱˪˲ˮ˹ 

 

˷˹˶ 21. ˴˹˲˻˸ˮ Send Object to Layout (˳˧ˮ˪˻˸ˮ˷ ˨˦˨ˬ˦˫˲˦ Layout-˾ )ˮ 

˧˶́˦˲˪˧˦ Send Object to Layout (˳˧ˮ˪˻˸ˮ˷ ˨˦˨ˬ˦˫˲˦ Layout-˾ )ˮ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ˦ ˱̄˳˰˳˩ ˩˦ 

˱̄˳˰˳˩ ˱˦˾ˮ˲, ˶˳˩˪˷˦̀ ˾˪˻˱˲ˮ˰ˮ ˳˧ˮ˪˻˸ˮ ˩˦˱˦̄˷˳˫˶˪˧˹˰ˮ˦ ˱˽˦˶ ˩ˮ˷˯ˬ˪. 

HUB-ˮ˷ ˯˳˲˺ˮ˨˹˶˦̀ˮ˦ 

Windows-˾ˮ  Hub ˱˹˾˦˳˧˷, ˶˳˨˳˶̀ ˺˳˲˹˶ˮ ˴˶˳˨˶˦˱˦(˷˹˶. 22). ˨˦˾˫˪˧ˮ˷˦˷ ˮ˷ ˮ̄˷˲˪˧˦ 

˨˦˱˳˽˳˺ˮ˰ ˺˦˲̅˦˶˦˾ˮ. Windows-˾ˮ Hub ˮ˦˶˰ˮ˽ˬ˪ ˭˦˨˹˲˦˷ ˱˦˶̅˫˪˲˦ ˼ˮ˰˦˯ˬ˪ ˱˳˻˱˪˩˪˧ˮ˭ 

˿˦˱˳˾˰ˮ˰ ˯˳˲˸˪˻˷˸˹˶ ˱˪˲ˮ˹˾ˮ ˴˹˲˻˸ˮ˷ Properties (˭˫ˮ˷˪˧˪˧ˮ) ˦˶˿˪˫ˮ˭ ˨˦˱˳˩ˮ˷ 

˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˦˶˦ Properties(˷˹˶. 23). 

 

˷˹˶ 22. Hub-ˮ˷ ˮ˦˶˰ˮ˽ˮ 

 

˷˹˶ 23. ˺˦˲̅˦˶˦ Properties 

˴˹˲˻˸ Options (˴˦˶˦˱˪˸˶˪˧ˮ)-˾ˮ ˫ˮ˱˳˻˱˪˩˳˭ ˮ˷˦˶ˬ˪, ˶˦˭˦ ˩˦˫˦˭˫˦˶ˮ˪˰˳˭ ̄˪˰˱ˮ˷˦̂˫˩˳˱ˮ 

˴˦˶˦˱˪˸˶˪˧ˮ. ˮ˱ˮ˷˦˭˫ˮ˷ ˶˳˱ Hub ˶˦˼˦̀ ˩˶˳ˮ˷ ˾˪˱˩˪˨ ˦˫˸˳˱˦˸˹˶˦˩ ˨˦ˮ˭ˮ˾˳˷ ˨˦˱˳˫ˮ˽˪˲˳˭ 

˱˪˲ˮ˹˷ ˴˹˲˻˸ˮ Automatic Shutdown (˦˫˸˳˱˦˸˹˶ˮ ˨˦˭ˮ˾˫˦). Layout ˩  ˦Modeler ˮ˲˸˪˶˺˪ˮ˷˪˧˾ˮ 



 

˦˫˸˳˱˦˸˹˶ˮ ˩˦˱˦̄˷˳˫˶˪˧˦ ̄˩˪˧˦ Automatic Save (˦˫˸˳˱˦˸˹˶ˮ ˩˦˱˦̄˷˳˫˶˪˧˦) ˧˶́˦˲˪˧ˮ˷ 

˱˪˾˫˪˳˧ˮ˭. 

˺˦ˮ˰˪˧˭˦˲ ˱˹˾˦˳˧˦ 

LightWave-˾ˮ ˿˫˪˲ ˾˪˫˻˱˲ˮ˭ ˳˧ˮ˪˻˸˪˧ˮ˷ ˩˦ ˷̀˪˲˪˧ˮ˷ ˺˦ˮ˰˪˧˷, ˶˳˱˰˪˧ˮ̀ ˱˳ˮ˭̄˳˫˪˲ 

˩˦˱˦̄˷˳˫˶˪˧˦˷ ˩˦ ˿˦˸˫ˮ˶˭˫˦˷. ˦˱ˮ˸˳˱ ˦˹̀ˮ˰˪˧˪˰ˮ˦ ˾˪˫ˮ˷̂˦˫˰˳˭, ˭˹ ˶˦ ˴˶ˮ˲̀ˮ˴ˮ˭ ̄˩˪˧˦ 

˪˷. 

˺˦ˮ˰˪˧ˮ˷ ˿ ˦˸˫ˮ˶˭˫˦ Layout  ˮ ˲˸˪˶˺˪ˮ˷˾ˮ 
˯˳˱˴˳˲˪˲˸˪˧ˮ˷ ˴˦˲˪˰ˬ˪ ˾˪˫˦˷˶˹˰˳˭ ˱˪˲ˮ˹˷ ˧˶́˦˲˪˧˦ File  -> Load -> Load Scene (˺˦ˮ˰ˮ -> 

˿˦˸˫ˮ˶˭˫˦ -> ˷̀˪˲ˮ˷ ˿˦˸˫ˮ˶˭˫˦)(˷˹˶. 24). ˨˦ˮ̄˷˲˪˧˦ ˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˦˶˦ Load Scene (˷̀˪˲ˮ˷ 

˿˦˸˫ˮ˶˭˫˦). 

 

˷˹˶ 24. ˷̀˪˲ˮ ˿˦˸˫ˮ˶˭˫ˮ˷ ˱˪˲ˮ˹˷ ˧˶́˦˲˪˧˦ 

˨˦˱˳˷˹˰ ˩ˮ˦˰˳˨˹˶ ˺˦˲̅˦˶˦˾ˮ ˦˫ˮ˶˿ˮ˳˭ ˷˦̃ˮ˶˳ ˷̀˪˲ˮ˷ ˺˦ˮ˰ˮ ˩˦ ˫ˮ˱˳˻˱˪˩˳˭ 

˯˰˦˫ˮ˦˸˶˦ˬ˪ ˦˶˷˪˧˹˰ Enter ˼ ˮ˰˦˯ˬ˪, ˦˲ ˩ˮ˦˰˳˨˹˶ ˺˦˲̅˦˶˦˾ˮ ˦˶˷˪˧˹˰ OK ˼ˮ˰˦˯ˬ˪ (˷˹˶. 

25). 

 

˷˹˶ 25. ˷̀˪˲ˮ˷ ˿˦˸˫ˮ˶˭˫ˮ˷ ˩ˮ˦˰˳˨˹˶ˮ ˺˦˲̅˦˶˦ 


